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AmphibiaTree Workshop Agenda 
 

Predictive Species Distribution Modeling  
Using Tree Data 

 
December 5-6, 2008 

Museum of Vertebrate Zoology, 3101 VLSB,  
and Geospatial Innovation Facility, 124 Mulford 

University of California, Berkeley 
 
 
Please note: Workshop Participants' Datasets: please bring a file of point localities for the 
taxa of interest in decimal degrees (e.g. *.xls, *.txt, tab or comma-delimited); sample sites 
should be identified with taxon or clade designations.  We will acquire additional occurrence 
data from online sources as well as discuss how to process environmental data available 
online, such as Worldclim 1.4 as part of the lab exercises. 
 
 
Day 1 (Friday, December 5th, MVZ) 
 
Agenda: Morning session: Museum of Vertebrate Zoology, 3101 VLSB, Grinnell-
Miller Library  
 
800-830: Welcome and Overview (David and Marvalee Wake) 
 
830- 930: Kenneth Kozak, University of Minnesota: The merging of historical biogeography and 
spatial ecology.  (See abstract) 
 
930-1000: Break 
 
1000-1100: William Collins, Lawrence Berkeley National Laboratory, University of 
California, Berkeley: Projections of Future Climate Change: What's Past is Prologue.   
 
1100-1200: Michelle Koo, MVZ, University of California, Berkeley: Species Distribution 
Modeling I: Basics, Background and Getting Started.  (See abstract) 
 
1200-130: Lunch Break; Afternoon session: GIF, 124 Mulford 
 
130-330: Data Preparation/Modeling Tutorial (Michelle Koo, aides) 

1



 
330-400: Break 
 
400-600: Lab Work:  Models and datasets: you will use your own data (see note preceding 
Day 1 reading list) to work with and evaluate models. 
  
700-930: Dinner:: Orso Restaurant 
 
 
Day 2 (Saturday, December 6th, MVZ) 
 
Agenda: Morning session before break: MVZ, Grinnell-Miller Library 
 
830-915: David Vieites, National Museum of Natural History, Madrid, Spain: Evolution of 
niches through time: How far can we go back? (See abstract) 
 
915-1000: William Monahan, Audubon California: Biological considerations when projecting species 
distribution models to novel environments. (See abstract) 
 
1000-1030:  Break; walk over to 124 Mulford 
 
1030-1230: Michelle Koo: Species Distribution Modeling II: Evaluation, Interpretation and Analysis.  
(See abstract) 
 
1230-130: Lunch Break 
 
130-300: Continue Model Evaluation 
 
300-330: Break 
 
330-530: Overview: Participant Feedback and Next Steps for AmphibiaTree 
 
800--: Dinner: Restaurante Venezia 
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Contents: 
 

• Abstracts of Speakers’ Presentations 
• Reading List and Relevant References 
• Exercise: Acquiring Data 

o Species Occurrence Samples 
o Bioclimatic Variables 

• Tutorial: Using DIVA-GIS 
• Preparing for Maxent 

o Sample data  
o Using ArcMap’s Model Builder to clip, project, and convert 

multiple ascii raster files 
o Creating a mask layer 

• Tutorial: Maxent 
o Quick model (current) 
o Projecting model into future 
o Evaluating in R (post-modeling evaluation) 

• Tutorial: Displaying, Converting Maxent Results in ArcGIS 
• Resource List 





Abstracts 
In order of presentation: 
 
Kenneth H. Kozak, University of Minnesota  

The merging of historical biogeography and spatial ecology 

Many biogeographic processes, ranging from speciation to the assembly of regional floras and 
faunas, are ultimately influenced by environmental variation over space and time. Yet, until 
recently, many studies in these general areas of evolutionary research ignored or employed only 
crude proxies for environmental variation (e.g. latitude, distance). With the availability GIS data 
and new spatial tools, biologists can now readily obtain environmental data for thousands of 
localities and hundreds of species across the globe, permitting them to more rigorously explore 
the underlying ecological and evolutionary causes of biogeographic patterns. Using case studies 
from tropical and temperate plethodontid salamanders, I will explore how these sources of 
environmental variation and phylogeny-based approaches can be integrated to provide fresh 
insights on the origin of new species and large-scale gradients in species diversity. Key 
conceptual and methodological challenges associated with integrating phylogenetic and spatial 
data over evolutionary timescales will be discussed.  

 

William Collins, Lawrence Berkeley National Laboratory, University of California, Berkeley  

Projections of Future Climate Change: What's Past is Prologue 

(Will be circulated when received)  

 

Michelle Koo, MVZ, University of California, Berkeley  

Species Distribution Modeling I: Basics, Background and Getting Started 

The goal of this workshop is to provide an understanding of the fundamental assumptions and 
theories of species distribution modeling and to present “best-practice” advice for data and 
model treatment. An introduction to species distributional modeling will include background on 
the rise of the natural history collection–based informatics, geospatial data, and the increasing 
concern for species and habitat predictions. Fundamentals of species modeling will include the 
theoretical differences between geographic space and environmental space and the varying 
scenarios that models may present and their respective implications. We will discuss the 
theoretical factors that affect model performance as well as selection of modeling method. 
Likewise, the fundamentals of the data necessary to species modeling will be examined closely, 
specifically understanding where majority of georeferenced specimen data can be found, inherent 
errors, and data-cleaning, as well as geospatial, climatic variables used, where to acquire them 
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and formatting for modeling. In the lab, we will explore datasets and their environmental space 
using DIVA-GIS, a free GIS program that was designed for species modeling. Preparing datasets 
for the algorithm and program Maxent will follow.  

Some workshop material is adapted from the teaching module for Species Distribution Modeling for 
Conservation by Richard Pearson of the Network of Conservation Educators and Practitioners (NCEP), 
Center of Biodiversity and Conservation at the AMNH and from the Geospatial Innovation Facility, 
UC Berkeley.  

 

David Vieites, National Museum of Natural History, Madrid, Spain  

Evolution of niches through time: How far can we go back? 

Modelling the ecological niches of species has become popular among ecologists and 
evolutionary biologists. Using current locality and climatic data is possible to develop statistical 
models to predict the fundamental niche of a species. While the fundamental niche is genetically 
and physiologically determined, the realized niche includes additional constraints arising from 
interspecific competition or biogeographic constraints. The combination of genetic data (e.g. 
phylogenetic or phylogeographic) with bioclimatic or physiological modelling is promising to 
study the evolution of species and their niches through time. However, there are few studies that 
investigated the evolutionary dynamics of fundamental niches in a phylogenetic context. Some 
of these used phylogenies to reconstruct the ancestral states of particular climatic variables. 
Others correlated environmental and genetic distances to evaluate niche dynamics and niche 
conservatism in pairs of sister species. These studies do not incorporate past global climatic 
changes so far, which may have a strong influence in the evolution of ecological niches, and may 
limit how far back in evolutionary time can we reconstruct them. I will review the state of the art 
in this field, providing examples about the integration of phylogenetic and bioclimatic data, and 
discuss the potential uses and limitations of these approaches.  

 

Bill Monahan, Audubon California  

Biological considerations when projecting species distribution models  
to novel environments 

Most studies using ecological niche models to predict changes in species’ distributions over 
space and time assume that species are in a state of distributional equilibrium with respect to the 
environment. Under this key assumption, species are expected to track environmentally induced 
changes in the geographic boundaries of their potential niche. However, an equally parsimonious 
and non-mutually exclusive hypothesis is that species respond geographically to environmental 
change by moving into and out of existing areas of potential niche space. These two possibilities 
raise important questions as to what we are modeling and how we interpret model predictions in 
both the training and projection environments. In addition to discussing such subjects through 
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case studies, I will present methods for testing the equilibrium assumption and ways for 
conditioning model results in situations where the assumption simply cannot be tested.  

 

Michelle Koo, MVZ, University of California, Berkeley  

Species Distribution Modeling II: Evaluation, Interpretation and Analysis 

The ease of generating species distribution models with many of the new algorithms, such as 
Maxent and DIVA-GIS, often belies the various technical hurdles to visualizing it in GIS for 
beginners, and the evolving studies on evaluating and interpreting the results. We will step 
through the process for beginners of GIS using ArcGIS 9 (ESRI) starting with data-acquisition, 
using time-saving steps for batch processing as well as discussing and performing thresholds for 
binary models, model performance indices such as Kappa’s and AUC’s, and projections to future 
climate or other alternative environmental datasets. The focus will be hands-on demonstration, 
emphasizing the practicalities of modeling with available tools, and whenever possible, 
participants will use their own dataset.  

Some workshop material is adapted from the teaching module for Species Distribution Modeling for 
Conservation by Richard Pearson of the Network of Conservation Educators and Practitioners (NCEP), 
Center of Biodiversity and Conservation at the AMNH and from the Geospatial Innovation Facility, 
UC Berkeley.  

 

6



Reading & Relevant Reference List 
Required Readings for the workshops are listed below by day and speaker request: 

To access references prior to the workshop, for your convenience, we have gathered pdfs in 
an online document database : BioGeoInformatics collection  (Select BioGeoInformatics for 
Collection, sort by author at  http://docubase.berkeley.edu/cgi/pl_search) 
Required readings are noted. To download, use the password, mvzgis 

Day 1 Readings, Friday, December 5th:  

Ken Kozak:  

• Kozak, K.H., C. H. Graham, and J. J. Wiens. 2008. Integrating GIS-based data into 
evolutionary biology. Trends in Ecology and Evolution 23:141-148.  

• Kozak, K. H., and J. J. Wiens. 2006. Does niche conservatism promote speciation? A 
case study in eastern North American salamanders. Evolution 60:2604-2621.  

William Collins: 

• Collins, W, R Colman, J Hayward, MR Manning, P Mote. 2007. The physical science 
behind climate change. Scientific American. 

Michelle Koo: 

• Elith and Graham et al. 2006 Novel methods improve prediction of species’ distributions 
from occurrence data. Ecography 29:129-151.  

• Graham, C. H., S. Ferrier, F. Huettman, C. Moritz, and A. T. Peterson. 2004. New 
developments in museum-based informatics and applications in biodiversity analysis. 
Trends in Ecology and Evolution 19:497-503.  

• Guisan, A and W. Thuiller. 2005. Predicting species distribution: offering more than 
simple habitat models. Ecology Letters 8:993-1009.  

• Phillips, S. J., R. P. Anderson, and R. E. Schapire. 2006. Maximum entropy modeling of 
species geographic distributions. Ecological Modelling 190:231-259.  

Day 2 Readings, Saturday, December 6th:  

David Vieites:  

• Graham, C. H., Ron, S. R., Santos, J. C., Schneider, C. J. and Moritz, C. 2004.  
Integrating phylogenetics and environmental niche models to explore speciation 
mechanisms in dendrobatid frogs. Evolution 58:1781-1793.  

• Pearman, P. B., Guisan, A., Olivier Broennimann, O. and Randin, C. F. 2007. Niche 
dynamics in space and time. TREE 23:148-158.  

• Yesson, C. and Culham, A. 2006. Phyloclimatic Modeling: Combining Phylogenetics and 
Bioclimatic Modeling. Systematic Biology 55:785-802.  
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William Monahan:  

• Araújo, M.B. & Pearson, R.G. (2005) Equilibrium of species’ distributions with climate. 
Ecography, 28, 693–695.  

• Hijmans, R.J. & Graham, C.H. (2006) The ability of climate envelope models to predict 
the effect of climate change on species distributions. Global Change Biology, 12, 2272–
2281.  

• Kearney, M. 2006. Habitat, environment and niche: what are we modelling? Oikos 115, 
86-91.  

 

Additional References of Interest:  
 
Anderson, RP, Lew D, and AT Peterson. 2003 Evaluating predictive modeling of species’ 
distributions: Criteria for selecting optimal models. Ecological Modelling 162:211-232.  

Fielding, A. H., and J. F. Bell. 1997. A review of methods for the assessment of prediction errors 
in conservation presence/absence models. Environmental Conservation 24:38-49.  

Graham, CH, J Elith, RJ Hijmans, A Guisan, AT Perterson, BA Loiselle and the NCEAS 
Predicting Species Distribution Working Group. 2008 The influence of spatial errors in species 
occurrence data used in distribution models. Journal of Applied Ecology 45:239-247  

Kidd, DM and X Liu 2008 Geophylobuilder 1.0: an ArcGIS extension for creating 
‘geophylogenies’. Molecular Ecology Resources 8:88-91.  

Peterson, A.T. 2003 Predicting the geographies of species’ invasions via ecological niche 
modeling. The Quarterly Review of Biology, 78, 419–433.  

Phillips, SJ and M Dudik. 2008 Modeling of species distributions with Maxent: new extensions 
and a comprehensive evaluation. Ecography, 31:161-175. 

Soberon 2007 Grinnellian and Eltonian niches and geographic distributions of species. Ecology 
Letters 10:1115-1123. 

 Svenning, J.-C. & Skov, F. 2004 Limited filling of the potential range in European tree species. 
Ecological Letters, 7, 565–573.  

 
More References and their doi links at:  

Species Distribution Modeling – Center for Biodiversity and Conservation, AMNH 

 (http://biodiversityinformatics.amnh.org/index.php?section=sdm_refer) 
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Acquiring Data from Online Sources 
(More online data sources in Resource Section) 

 
I. Species Occurrence Data: from HerpNET 
 
1. Open browser to http://www.herpnet.org/portal.html. Click at top left link to Search 
Specimens 

 
Read thoroughly and verbally agree with conditions as you click ‘Search Museum Data.’ 
Click through next window to ‘Build Query’. 
 
2. Query Form: First select a subset of data providers (presently selecting all data 
providers in a single query often causes an error, so to avoid this select a few at time) 
Shift-click two rows will select all contiguous rows; Cntrl-click will select non-
contiguous rows. (Grey rows are selected in image.) 
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Continue to scroll down to: 1) select query conditions; 2) select a record limit (set 1000 
for now); 3) Hit Submit 
 

 
 
3. Search Results will look like this: you can re-run the query but adjust the record limit 
and institution selection as appropriate to acquire records of interest, then  
 

 
Click on the Download button (4). 

2 

1 

3 

4 
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II. To format for use in Maxent: 
Finally open the downloaded tab-delimited text file in Excel (it may be necessary to add 
an extension, .txt, to the file if the extension has been stripped by the browser.) 
 
There will be some query information in the header, which can be useful if you run a lot 
of these queries from HERPNET. For now, we will only copy and paste the following 3 
fields into a new Excel Workbook: Scientific name, DecimalLatitude, DecimalLongitude 
 

(Note the field: “Coordinate uncertainty in meters”. This may be useful to cull the vague 
locality descriptions from better, more precise ones 
Also, ideally the coordinates will all be in the same Datum; for this exercise let’s ignore the 
differences as the datum shift between different datums will not have a noticeable effect at 
the global resolutions in which we are working.) 

 
Change the column order to: ScientificName, Longitude, Latitude and  
save as *.csv file in Excel. 
 
 
III. GIS and Climate Data: from Worldclim  
 
1. Point a browser window to: http://www.worldclim.org/ 
 
WorldClim is a set of global climate layers (climate grids) with a spatial resolution of 
up to one square kilometer. It can be used for mapping and spatial modeling in a 
GIS or other computer program. The data are described in: Hijmans, R.J., S.E. 
Cameron, J.L. Parra, P.G. Jones and A. Jarvis, 2005. Very high resolution 
interpolated climate surfaces for global land areas. International Journal of 
Climatology 25: 1965-1978 
 
Available datasets:  
 

Current Climate: 
1950-2000 
 

Future Models: IPCC 
3rd assessment,  
2020, 2050, 2080 

Future Model: CCM3 
Scenario: 2XCO2 

Worldclim 1.4 
(see above for ref) 

CCCMA (a2a,b2a) 
HADCM3 (a2a,b2a) 
CSIRO (a2a, b2a) 
(see IPCC website for 
reference) 

B. Govindasamy, P. B. 
Duffy, J. Coquard, 2003. 
High-resolution simulations 
of global climate, part 2: 
effects of increased 
greenhouse cases. Climate 
Dynamics 21: 391–404. 

Resolutions: 
 
30 arc-seconds  
(ca. 1 km2),  
2.5 arc minutes  
(ca. 5 km2),  
5 arc minutes  
(ca. 9 km2),  
10 arc-minutes  
(ca. 18 km2) 
 http://www.worldcl

im.org/current.htm 
http://www.worldclim.
org/futdown.htm 

http://www.worldclim.org/
future.htm 

 
2. Also, download a vector shapefile for the country(s) in which you are studying— 
Country-level GIS layers from DIVA-GIS:    http://biogeo.berkeley.edu/bgm/gdata.php    
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WORLDCLIM  

(from http://www.worldclim.org/bioclim.htm) 

 

BIOCLIM 

Bioclimatic variables are derived from the monthly temperature and rainfall values in 
order to generate more biologically meaningful variables. These are often used in 
ecological niche modeling (e.g., BIOCLIM, GARP). The bioclimatic variables represent 
annual trends (e.g., mean annual temperature, annual precipitation) seasonality 
(e.g., annual range in temperature and precipitation) and extreme or limiting 
environmental factors (e.g., temperature of the coldest and warmest month, and 
precipitation of the wet and dry quarters). A quarter is a period of three months (1/4 
of the year). 

They are coded as follows: 

BIO1 = Annual Mean Temperature 
BIO2 = Mean Diurnal Range (Mean of monthly (max temp - min temp)) 
BIO3 = Isothermality (P2/P7) (* 100) 
BIO4 = Temperature Seasonality (standard deviation *100) 
BIO5 = Max Temperature of Warmest Month 
BIO6 = Min Temperature of Coldest Month 
BIO7 = Temperature Annual Range (P5-P6) 
BIO8 = Mean Temperature of Wettest Quarter  
BIO9 = Mean Temperature of Driest Quarter 
BIO10 = Mean Temperature of Warmest Quarter 
BIO11 = Mean Temperature of Coldest Quarter 
BIO12 = Annual Precipitation 
BIO13 = Precipitation of Wettest Month 
BIO14 = Precipitation of Driest Month 
BIO15 = Precipitation Seasonality (Coefficient of Variation) 
BIO16 = Precipitation of Wettest Quarter 
BIO17 = Precipitation of Driest Quarter 
BIO18 = Precipitation of Warmest Quarter 
BIO19 = Precipitation of Coldest Quarter 

This scheme follows that of ANUCLIM, except that for temperature seasonality the 
standard deviation was used because a coefficient of variation does not make sense 
with temperatures between -1 and 1). 

 

NOTE: An AML script for ArcINFO is available at the same webpage, which will calculate the 
above bioclimatic averages from Tmax, Tmin, Precip monthly variables. 
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DIVA-GIS 
Tutorial: Modeling Species Distributions 

Modified from DIVA-GIS Tutorial v5.2 for AmphibiaTree 
 
 
DIVA-GIS -- a free GIS program designed for exploring and analyzing species 
occurrence date with environmental layers (http://www.diva-gis.org/). 
 
 
Part I: Add shapefiles. 
These are outline or vector files. 
They are composed of many files (3-7) with the same name but different extensions 

(when browsing via GIS, you will only see and load the main file, *.shp) 
 
To add a shape file to the project: 
LAYER: ADD LAYER (or “+” icon) 
Select country shapefile from previous exercise (e.g. “CostaRica.shp” from 

C:\WorkSpace\AmphibiaTree\DIVA\ 
Click OK 
 
Save your project  (e.g., myproject.div)in the C:\WorkSpace\AmphibiaTree\DIVA\ 

directory.   
Click OK 
 
Part II: Add “point” files 
These are files with individual places, or “localities” (dots on a map). 
They are generally text files (*.txt, *.csv, etc) that can be easily created from Excel files. 
 
To convert a text file of points to a shape file and add it to the project: 
DATA: IMPORT POINTS TO SHAPEFILE: FROM TEXT FILE 
Browse to correct text file  
 
The field delimiter is set by default to “tab”, so change to Comma if using the 

downloaded HerpNET data; the X and Y fields are set to recognize the Long and Lat 
headers.  If the correct headers were not recognized in your data, you can set them 
through the drop down options. Name the output shapefile (e.g. myfavoritetaxa.shp). 

 
Click APPLY to create the shapefile, and CLOSE to leave the dialog. 
 
Part III. Add “grid” (“raster”) files 
A raster or grid dataset for GIS is comprised of equal-sized cells, each one containing a 

value of one characteristic.  
They can come in many formats, but ascii (*.asc) is a common one. 
We will use the elevational and climatic data from downloaded from the WorldClim 

datasource (http://www.worldclim.org/; see previous section). 
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To import grid (raster) files from ascii and convert them to DIVA grids (*.grd): 
 
Start with alt.asc 
DATA> IMPORT TO GRIDFILE> SINGLE FILE 
Set the “File Type” to ESRI ASCII 
Browse to “alt.asc” for the input file and click OK 
 
Now add the 19 climatic layers below: 

BIO1 = Annual Mean Temperature 
BIO2 = Mean Diurnal Range (Mean of monthly (max temp - min temp)) 
BIO3 = Isothermality (P2/P7) (* 100) 
BIO4 = Temperature Seasonality (standard deviation *100) 
BIO5 = Max Temperature of Warmest Month 
BIO6 = Min Temperature of Coldest Month 
BIO7 = Temperature Annual Range (P5-P6) 
BIO8 = Mean Temperature of Wettest Quarter  
BIO9 = Mean Temperature of Driest Quarter 
BIO10 = Mean Temperature of Warmest Quarter 
BIO11 = Mean Temperature of Coldest Quarter 
BIO12 = Annual Precipitation 
BIO13 = Precipitation of Wettest Month 
BIO14 = Precipitation of Driest Month 
BIO15 = Precipitation Seasonality (Coefficient of Variation) 
BIO16 = Precipitation of Wettest Quarter 
BIO17 = Precipitation of Driest Quarter 
BIO18 = Precipitation of Warmest Quarter 
BIO19 = Precipitation of Coldest Quarter 

 
DATA: IMPORT TO GRIDFILE: MULTIPLE FILES 
Set the “Type” to ARC ASCII 
Click ADD FILE 
Browse to C:\WorkSpace\AmphibiaTree\ and use the shift key select appropriate files 
Click OK 
Click APPLY 
 
LAYER: ADD LAYER (or “+” icon) 
Select one of the new *.grd files to observe the data 
OPEN 
 
Part IV: Make a model of a species’ potential distribution: 
 
To “stack” DIVA grids (make a file that links all the grid files to be used in modeling): 
Click STACK>MAKE STACK> ADD GRID 
Browse to correct folder, select all appropriate *.grd files (all 19 climatic variables) with 

the shift key 
OPEN 
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Click STACK, browse to desired location and name the stack (e.g., extent_bc_1_19.grs) 
Click APPLY, then CLOSE 
 
To examine environmental data for occurrence records and make BIOCLIM 

(Hutchinson’s) niche model: 
 
1. Click  the species shapefile (on left panel) with cursor to activate the layer 
 
2. Click on menu MODELING> BIOCLIM / DOMAIN  

 
 
3. INPUT (will have point file you selected) 
 Use STACK 
 Browse to your stack 

Select appropriate file (e.g “extent_bc_1_19.grs”) 
OPEN 

 
4. FREQUENCY, OUTLIERS, HISTOGRAM, ENVELOPE are for data-exploration. 

FREQUENCY—cumulative frequency distribution plots for climatic variables, 
up to 2 classes; useful to spot outliers.  
Click on a point in graph to see corresponding locality in map.  
OUTLIERS—plots in environmental space (1 to n variables, up to the max of 
variables in stack). 
Click on a line in graph to see corresponding locality in map. 
HISTOGRAM—displays a variable and a class, with min/ max values that you 
can set. 
ENVELOPE—shows values for 2 variables for the occurrence records. 

Select any 2 climatic variables. 
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Select 0.00 percentile excluded (to delimit full fundamental niche); this will be 
applied to all variables, even though you only see a plot of two of them. 
APPLY 
 

NOTE: *EXTRACT—click this to create a text file of all variable values for point file. 
 
Graph colors: points within the envelope for all climate variables are GREEN;  
points that fall outside at least one envelope are RED 
Map colors: points within the 2-dimensional envelope on the graph are YELLOW on the map 
(selected). 
 

5. OPTIONAL: Before moving to the PREDICT tab, go to menu bar 
MODELING>EVALUATION>SAMPLE POINTS 

 
This will split your point file into a training and testing set of shapefiles. You will use the 
*_train.shp for the input in the modeling and the *_test.shp for evaluation files (ROC and 
Kappa). 
 
6. PREDICT 

Set the OUTPUT GRID DIMENSIONS to MAXIMUM EXTENT (of your climatic 
coverages). Select variables and desired limits (upper, lower); Use all 19 here, with 
both upper and lower limits checked. 

 Click OUTPUT, and browse to desired location and give name for prediction (e.g., 
bio1to19.grd) 
APPLY  

Save your project  (e.g., Bioclim_myfavoritetaxa.div)! 
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Environmental Dataset Preparation for Maxent  
Using the ArcMap Model Builder to reproject, clip and export to multiple ASCII files 

Compiled by: Kevin Koy, GIF; modified by MSK for AmphibiaTree 
 
BACKGROUND 
In order to use environmental data layers in Maxent, the data must be in ASCII grid format, and 
all layers must have the same geographic bounds and cell size.  This guide is a brief description 
of ONE method that can be employed to format Worldclim bioclimatic data for use in Maxent.  
By no means is this the only way to accomplish this formatting, but it is a working method that is 
relatively easy to use, allows batch processing, and is customizable. 
 
This guide using Worldclim data as its example, as it is a common source of data used in 
Maxent, however, these methods may be adapted to format other environmental data layers.   
 
 
INSTRUCTIONS 
 
1. Open ArcMap (this guide was written using version 9.3), and open the ArcToolbox. 
 
2. Right-click in the white space of the Toolbox, and click New Toolbox to create an area to 
build your model. 
 

 
 
 
 
 
 
3. Right-click on the name of the new toolbox that you have created and select New > Model as 
seen below. 
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4. In the new Model window that opens, you can drag and drop any of the tools from the toolbox.   
Begin by navigating to Data Management Tools > Raster > Raster Processing then drag and 
drop the Clip tool from the toolbox to the model builder.  You should see two connected objects 
appear as seen below. 
 

 
 
 

5. Follow with the Project tool which is found in Data Management Tools > Projections and 
Transformations>Raster  
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6. Follow with the Raster to ASCII tool which is found in Conversion Tools > From Raster as 
seen below. 
 

 
 
 
7. Next, you will need to add an Input Raster variable, this is done by right-clicking in the model 
window, and selecting Create Variable… as seen below. 
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8. Select Raster Layer in the menu that comes up, as seen below.  This will add an oval “Input 
Raster” to your model. 

 
 
9. In order to set the Input Raster to accept multiple files, right click on the newly created oval, 
and choose Properties.  In the properties dialog, choose “A series of values.”  Click OK. 
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10.  Next we will need to connect the different variables and processes in the model.  To make 
these connections, choose the Add Connection  tool.  Drag the wand from the starting 
variable (oval) to the connecting process (rectangle).  Use the example below to create all of the 
necessary connections. 
 

 
 
 

11.  The basic format of the 
model is now complete. Next 
we will set up the specific 
variables for your area of 
interest.  Double-click the 
Input Raster oval, and use 
the “+” sign to create the 
appropriate number of entry 
spaces.  Populate these 
spaces with the chosen 
bioclimatic variables.  This 
can be done by double-
clicking and selecting each 
file or copy/pasting the paths.  
An easy method to do this is 
to use EXCEL to create your 
entries, and copy/paste into 
the input. 
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For demonstration purposes in this exercise we will use a subset of the 19 bioclimatic variables 
at 1 km: (located here: C:\Workspace|AmphibiaTree\Worldclim\current\) 
 
 
12.  Next, we will set the projection by double-clicking the Project rectangle.  Leave the Input 
and Output Raster with the default values.  Choose a projection in the Output Coordinate System 
section that makes sense for your area of interest.  It is usually best to use a projection where the 
units are in meters.  Lastly, choose a Resampling Technique, and set your desired output cell 
size, then click OK.  In the example below, this uses the UTM coordinate system Zone 48, 
which falls over Vietnam. 
 

 
 

For our exercise, we will use the projection Albers Equal-Area Conic that is specific to the 
continent of your modeling interest. To find that, click the button to the right of Output 
Coordinate System, which will bring up the Spatial Reference Properties window. Click on 
Select and in the Browse window, follow this path to your appropriate projection: 
Projected Coordinate Systems>Continent> (choose Africa, Asia, Europe, North America, 
South America) 
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13. Next, double-click the Clip rectangle to set the extent of your study area.  Enter the 
maximum and minimum x and y values, and leave the rest of the entries as is. To capture the 
extent of California for example, use the lat & long values below: 
Y Maximum:  42.5 
Y Minimum:  32.0 
X Minimum: -125 
X Maximum: -113.5 
 

 
 

To approximate the Bounding Box for your area of interest, open a new ArcMap session and add 
in your country shapefile; now, in the Drawing menu, use the rectangle tool to draw the area you 
wish to clip (e.g. draw a box over the country shape, it will be larger than the country 
boundaries). Right-click on your drawn rectangle, open Properties> Size and Position.  
 

Click on the Upper Left blue button to 
see the extent of the bounding box’s 
maximum X and Y values  in map units 
(if it is the unprojected dataset, this will 
be in decimal degrees). Copy/paste 
values to the appropriate fields in the 
Clip Tool. 
 
Do the same for the Lower Right blue 
button and the values that correspond to 
the Minimum X and Y. (You can round 
the values to whole numbers.) 
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14.  Next, double-click the Raster to ASCII rectangle to set the output file names.  In order to 
save multiple files that correspond with the multiple input files, you must enter a variable %n% 
which lets the model know that it will iterate through the files, and the output will iterate plus 
one through the output file names in place of the n.  See the example below for a sample of this 
format. 
 

 
 
15. Next, set the model to iterate through the values by right-clicking in model window (white 
space), and choosing Model Properties.  In the dialog box, choose the Iteration tab at the top, 
and set the “Get the iteration count from this variable” to bio_1, or whatever the name of your 
input layer variable is.  The number can remain 1 as it uses the variable to count. 
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16. The model is now complete and ready to run.  Be sure to save your model, and save your 
project in ArcMap.  The model is stored independently in each mxd project file, and will not be 
immediately available in new projects (but can be added to new ArcMap sessions). 
 
17. To run the model, push the Run button .  You should see a dialog box that displays the 
processes that are being run.  For example, for 19 bioclim variables, you should see 57 (3 each) 
processes that will be run.  You may notice two temporary files that are created to run the model.  
When the model is finished, you can delete these files by choosing Model > Delete 
Intermediate Data from the model builder menu.   
 

NOTE: the model number generator begins with 0, so your files will be numbered 
 0-18, rather than 1-19.  You will have to rename the ASCII files to correct for this. 

 
This is a very basic introduction to Model Builder, which should help to run multiple processes 
on multiple files with less user input.  There are many more capabilities within this environment, 
including exporting to a script that can be used more generically for other files and may be worth 
your while to explore. 
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 Specimen Dataset Preparation- Map Projection  
Projecting and exporting Specimen data for Maxent in ArcMap 

 
If you use environmental data in a map projection then you will also need to project the 
specimen dataset to the same map projection.  
 
1. Add specimen point shapefile from DIVA-GIS exercise to ArcMap by clicking on the “+”. 
 
2. Project shapefile to same projection chosen for raster ascii files by opening the ArcToolbox 

Data Management Tools>Projections & Transformations>Feature>Project; choose the 
same projection as the grid dataset (see above). 

 
3. With the new projected shapefile, added to ArcMap, right-click on the Tool Bar and check off 

Editor. This will add a new set of tools enabling shapefile edits.  
Click on Editor> Start Editing 

 
4. Right-click on the newly projected shapefile to Open Attribute Table. Now right-click on the  

Field heading for the X/Longitude value and click on Calculate Geometry. Click OK. This 
will replace the field values with the projected values in their appropriate units (here, meters). 
Do the same for the Y/Latitude field but change Property to Y Coordinate of Point (circle 
below). Click OK. 

 

 
 
5. The last step is to export the data as a text file (Options>Export from the Attribute Table); 

you may need to edit the exported text file in Excel to get rid of unnecessary fields and save 
as *.csv (see previous section Acquiring Data). 
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 Creating a mask layer: 
How to create a mask in ArcMap for use in Maxent  

 
 
 
It is often desirable to use a mask layer with Maxent so that the analysis is limited only to your 
area of interest.  The mask file will contain pixels of “1” values for areas to include, and “0” 
values in pixels that will be excluded.  In this example, we will create a raster mask using the 
state boundary of California, based on the extent and resolution of our climate data that has 
already been formatted. 

With your dataset, use the country shapefile from GADM dataset as a mask for your area of 
interest and substitute below as appropriate in the California example. 

 
1. Load one of the formatted climate layers into ArcMap. In this example, click the Add Data 
button, and choose CA_bio1.asc. This file, already clipped to the maximum extent, will be a 
template for our mask. 
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2. Make sure that the Spatial Analyst Extension is checked on: Tools > Extensions, and access 
the Spatial Analyst toolbar through View > Toolbars > Spatial Analyst. 
 

 
 
3. In the Spatial Analyst drop down menu, choose Options.  Here you can set the Extent and Cell 
size for all Spatial Analyst processes to match another file. 
 
4. In the Extent tab, choose Same as Layer “ca_bio1.asc” as the Analysis Extent. 
 

 
 

5. Next, choose Same as Layer “ca_bio1.asc” as the Analysis cell size. Then click OK. 
 

. 
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6. Now, we can add a vector shapefile to the project that can be used to determine the state 
boundary.  In this example, click the Add Data button, and choose US_states.shp.  Then use the 
select Features tool to select California. This should highlight the state in blue. 
 

 
 
7. Next, in the Spatial Analyst drop down menu, choose Convert > Features to Raster.  Choose 
a directory to save the new Grid file.  Because we have already defined the extent and cell size 
the output file will match the other files identically, and only California will be output as it is the 
only feature selected. 

 

 
 

8. The resulting file is nearly complete, however the cell number has been set to “9” which is 
California’s object ID.  In order to change this value to “1” go to Reclassify in the Spatial 
Analyst drop down menu.  
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9. The setup should be ready to go as is, you can see that the old value “9” will be replaced by 
the new value “1” with this function.  Click OK to run, the resulting file is a temporary grid 
called Reclass of ca.   
 
10. Lastly, in order for this file to be read in Maxent, it must be converted to an ascii grid.  Open 
ArcToolbox, and choose Conversion Tools > From Raster > Raster to ASCII.  Enter the input 
file “Reclass of ca” using the drop down menu, and choose an output directory and name.  Be 
sure to use the .asc extension so that Maxent knows it is a grid file. 
 

 

 
 

This output file will result in a mask that can be used to limit the area of interest in a Maxent 
analysis.  Be sure that this file is located in the same directory as your other climate data files. 
 
RS/GIS Quick Start Guides  
These materials are freely available for use and modification through a  
Creative Commons Attribution-Share Alike 3.0 License. 
License details: http://creativecommons.org/licenses/by-sa/3.0/us/ 
Version: Original document was created by GIF (2008); modified for AmphibiaTree 
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A Brief Tutorial on Maxent  
By Steven Phillips, AT&T Research 

Modified by Michelle S. Koo for AmphibiaTree, Dec 2008. 
  

This tutorial gives a basic introduction to use of the MaxEnt program for maximum entropy modelling of 
species’ geographic distributions, written by Steven Phillips, Miro Dudik and Rob Schapire, with support 
from AT&T Labs-Research, Princeton University, and the Center for Biodiversity and Conservation, 
American Museum of Natural History.  For more details on the theory maximum entropy modeling as well 
as a description of the data used and the main types of statistical analysis used here, see: 
 
    Steven J. Phillips, Robert P. Anderson and Robert E. Schapire, Maximum entropy modeling of species 
geographic distributions.  Ecological Modelling, Vol 190/3-4 pp 231-259, 2006. 
 
A second paper describing more recently-added features of the Maxent software is: 
 
    Steven J. Phillips and Miroslav Dudik, Modeling of species distributions with Maxent: new 
extensions and a comprehensive evaluation.  Ecography, 31:161-175, 2008. 
 
The environmental data we will use consist of climatic and elevational data for South America, together 
with a potential vegetation layer.  Our sample species will be Bradypus variegatus, the brown-throated 
three-toed sloth.  This tutorial will assume that all the data files are located in the same directory as the 
maxent program files; otherwise you will need to use the path (e.g., C:\WorkSpace\AmphibiaTree\) in front 
of the file names used here. 
 
Getting started 
 
Downloading 
 
The software consists of a jar file, maxent.jar, which can be used on any computer running Java version 1.4 
or later.  Maxent can be downloaded, along with associated literature, from 
www.cs.princeton.edu/~schapire/maxent; the Java runtime environment can be obtained 
from java.sun.com/javase/downloads.  If you are using Microsoft Windows (as we assume here), you 
should also download the file maxent.bat, and save it in the same directory as maxent.jar.  The website has 
a file called “readme.txt”, which contains instructions for installing the program on your computer. 
 
Firing up 
 
If you are using Microsoft Windows, simply click on 
the file maxent.bat.   
Otherwise, enter "java -mx512m -jar maxent.jar" in a 
command shell (where "512" can be replaced by the 
megabytes of memory you want made available to the 
program).  The following screen will appear:  

 
 
 
To perform a run, you need to supply a file containing 
presence localities (“samples”), a directory containing 
environmental variables, and an output directory.        
In our case, the presence localities are in the file 
“samples\bradypus.csv”, the environmental layers are 
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in the directory “layers”, and the outputs are going to the directory “outputs”.  You can enter these 
locations by hand, or browse for them.  While browsing for the environmental variables, remember that you 
are looking for the directory that contains them – you don’t need to browse down to the files in the 
directory.  After entering or browsing for the files for Bradypus, the program looks like this: 
 

 
 

 
The file “samples\bradypus.csv” contains the presence localities in .csv format. The first few lines are as 
follows: 
 
species,longitude,latitude 
bradypus_variegatus,-65.4,-10.3833 
bradypus_variegatus,-65.3833,-10.3833 
bradypus_variegatus,-65.1333,-16.8 
bradypus_variegatus,-63.6667,-17.45 
bradypus_variegatus,-63.85,-17.4 
 
There can be multiple species in the same samples file, in which case more species would appear in the 
panel, along with Bradypus.  Coordinate systems other than latitude and longitude can be used provided 
that the samples file and environmental layers use the same coordinate system.  The “x” coordinate 
(longitude, in our case) should come before the “y” coordinate (latitude) in the samples file.  If the presence 
data has duplicate records (multiple records for the same species in the same grid cell), the duplicates can 
be removed by clicking on the “Settings” button and selecting “Remove duplicate presence records”. 
 
The directory “layers” contains a number of ascii raster grids (in ESRI’s .asc format), each of which 
describes an environmental variable.  The grids must all have the same geographic bounds and cell size (i.e. 
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all the ascii file headings must match each other perfectly).  One of our variables, “ecoreg”, is a categorical 
variable describing potential vegetation classes.  The categories must be indicated by numbers, rather than 
letters or words.  You must select the variable type, as has been done in the picture above. 
 

Doing a run 
 
Simply press the “Run” button.  A progress monitor describes the steps being taken.  After the 
environmental layers are loaded and some initialization is done, progress towards training of the maxent 
model is shown like this: 
 

 
 

The gain is closely related to deviance, a measure of goodness of fit used in generalized additive and 
generalized linear models.  It starts at 0 and increases towards an asymptote during the run.  During this 
process, Maxent is generating a probability distribution over pixels in the grid, starting from the uniform 
distribution and repeatedly improving the fit to the data.  The gain is defined as the average log probability 
of the presence samples, minus a constant that makes the uniform distribution have zero gain.  At the end of 
the run, the gain indicates how closely the model is concentrated around the presence samples; for example, 
if the gain is 2, it means that the average likelihood of the presence samples is exp(2) ≈ 7.4 times higher 
than that of a random background pixel.  Note that Maxent isn’t directly calculating “probability of 
occurrence”.  The probability it assigns to each pixel is typically very small, as the values must sum to 1 
over all the pixels in the grid (though we return to this point when we compare output formats).  
 
The run produces multiple output files, of which the most important for analyzing your model is an html 
file called “bradypus.html”.  Part of this file gives pointers to the other outputs, like this: 
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Looking at a prediction 
 
To see what other (more interesting) output there can be in bradpus.html, we will turn on a couple of 
options and rerun the model.  Press the “Make pictures of predictions” button, then click on “Settings”, and 
type “25” in the “Random test percentage” entry.  Then, press the “Run” button again.  After the run 
completes, the file bradypus.html contains a picture like this: 
 

 
 

The image uses colors to indicate predicted probability that conditions are suitable, with red indicating high 
probability of suitable conditions for the species, green indicating conditions typical of those where the 
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species is found, and lighter shades of blue indicating low predicted probability of suitable conditions.  For 
Bradypus, we see that suitable conditions are predicted to be highly probable through most of lowland 
Central America, wet lowland areas of northwestern South America, the Amazon basin, Caribean islands, 
and much of the Atlantic forests in south-eastern Brazil. The file pointed to is an image file (.png) that you 
can just click on (in Windows) or open in most image processing software. If you want to copy these 
images, or want to open them with other software, you will find the .png files in the directory called “plots” 
that has been created as an output during the run.   
 
The test points are a random sample taken from the species presence localities.  The same random sample is 
used each time you run Maxent on the same data set, unless you select the “random seed” option on the 
settings panel.  Alternatively, test data for one or more species can be provided in a separate file, by giving 
the name of a “Test sample file” in the Settings panel.   
 
Output formats 
 
Maxent supports three output formats for model values: raw, cumulative and logistic.  First, the raw output 
is just the Maxent exponential model itself.  Second, the cumulative value corresponding to a raw value of r 
is the percentage of the Maxent distribution with raw value at most r.  Cumulative output is best interpreted 
in terms of predicted omission rate: if we set a cumulative threshold of c, the resulting binary prediction 
would have omission rate c% on samples drawn from the Maxent distribution itself, and we can predict a 
similar omission rate for samples drawn from the species distribution.  Third, if c is the exponential of the 
entropy of the maxent distribution, then the logistic value corresponding to a raw value of r is c·r/(1+c·r).  
This is a logistic function, because the raw value is an exponential function of the environmental variables.  
The three output formats are all monotonically related, but they are scaled differently, and have different 
interpretations.   
The default output is logistic, which is the easiest to conceptualize: it gives an estimate between 0 and 1 of 
probability of presence.  Note that probability of presence depends on details of the sampling design, such 
as the plot size and (for vagile organisms) observation time; logistic output estimates probability of 
presence assuming that the sampling design is such that typical presence localities have probability of 
presence of about 0.5.  The picture of the Bradypus model above uses the logistic format.  In comparison, 
using the raw format gives the following picture: 

 
Note that we have used a logarithmic scale for the 
colors.  A linear scale would be mostly blue, with a 
few red pixels (you can verify this by deselecting 
“Logscale pictures” on the Settings panel) since the 
raw format typically gives a small number of sites 
relatively large values – this can be thought of as an 
artifact of the raw output being given by an 
exponential distribution. 
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Using the cumulative output format gives the following picture: 
 

 
 
As with the raw output, we have used a 
logarithmic scale for coloring the picture in 
order to emphasize differences between smaller 
values. Cumulative output can be interpreted as 
predicting suitable conditions for the species 
above a threshold in the approximate range of 1-
20 (or yellow through orange, in this picture), 
depending on the level of predicted omission 
that is acceptable for the application.   
 
 
 
 
 
 
 
 
 
 
 
 

 
Statistical analysis 
 
The “25” we entered for “random test percentage” told the program to randomly set aside 25% of the 
sample records for testing.  This allows the program to do some simple statistical analysis.  Much of the 
analysis used the use of a threshold to make a binary prediction, with suitable conditions predicted above 
the threshold and unsuitable below.  The first plot shows how testing and training omission and predicted 
area vary with the choice of cumulative threshold, as in the following graph: 
 

 
 
Here we see that the omission on test samples is a very good match to the predicted omission rate, the 
omission rate for test data drawn from the Maxent distribution itself.  The predicted omission rate is a 
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straight line, by definition of the cumulative output format.   In some situations, the test omission line lies 
well below the predicted omission line: a common reason is that the test and training data are not 
independent, for example if they derive from the same spatially autocorrelated presence data. 
 
The next plot gives the receiver operating curve for both training and test data, shown below.  The area 
under the ROC curve (AUC) is also given here; if test data are available, the standard error of the AUC on 
the test data is given later on in the web page. 
 

 
 
If you use the same data for training and for testing then the red and blue lines will be identical. If you split 
your data into two partitions, one for training and one for testing it is normal for the red (training) line to 
show a higher AUC than the blue (testing) line. The red (training) line shows the “fit” of the model to the 
training data. The blue (testing) line indicates the fit of the model to the testing data, and is the real test of 
the models predictive power. The turquoise line shows the line that you would expect if your model was no 
better than random. If the blue line (the test line) falls below the turquoise line then this indicates that your 
model performs worse than a random model would. The further towards the top left of the graph that the 
blue line is, the better the model is at predicting the presences contained in the test sample of the data. For 
more detailed information on the AUC statistic a good starting reference is:  

Fielding, A.H. & Bell, J.F. (2007) A review of methods for the assessment of prediction errors in 
conservation presence/ absence models. Environmental Conservation 24(1): 38-49.   

Because we have only occurrence data and no absence data, “fractional predicted area” (the fraction of the 
total study area predicted present) is used instead of the more standard commission rate (fraction of 
absences predicted present).  For more discussion of this choice, see the paper in Ecological Modelling 
mentioned on Page 1 of this tutorial.  It is important to note that AUC values tend to be higher for species 
with narrow ranges, relative to the study area described by the environmental data.  This does not 
necessarily mean that the models are better; instead this behavior is an artifact of the AUC statistic. 
 
If test data are available, the program automatically calculates the statistical significance of the prediction, 
using a binomial test of omission.  For Bradypus, this gives: 
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For more details on the binomial statistic, see the Ecological Modelling paper mentioned above. 
 
Which variables matter most? 
 
A natural application of species distribution modeling is to answer the question, which variables matter 
most for the species being modeled?  There is more than one way to answer this question; here we outline 
the possible ways in which Maxent can be used to address it.   
 
While the Maxent model is being trained, we can keep track of which environmental variables are making 
the greatest contribution to the model.  Each step of the Maxent algorithm increases the gain of the model 
by modifying the coefficient for a single feature; the program assigns the increase in the gain to the 
environmental variable(s) that the feature depends on.  Converting to percentages at the end of the training 
process, we get the following table: 
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These percent contribution values are only heuristically defined: they depend on the particular path that the 
Maxent code uses to get to the optimal solution, and a different algorithm could get to the same solution via 
a different path, resulting in different percent contribution values.  In addition, when there are highly 
correlated environmental variables, the percent contributions should be interpreted with caution.  In our 
Bradypus example, annual precipitation is highly correlated with October and July precipitation.  Although 
the above table shows that Maxent used the October precipitation variable more than any other, and hardly 
used annual precipitation at all, this does not necessarily imply that October precipitation is far more 
important to the species than annual precipitation. 
 
To get alternate estimates of which variables are most important in the model, we can also run a jackknife 
test by selecting the “Do jackknife to measure variable important” checkbox.  When we press the “Run” 
button again, a number of models are created.  Each variable is excluded in turn, and a model created with 
the remaining variables.  Then a model is created using each variable in isolation.  In addition, a model is 
created using all variables, as before.  The results of the jackknife appear in the “bradypus.html” files in 
three bar charts, and the first of these is shown below. 
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We see that if Maxent uses only pre6190_l1 (average January rainfall) it achieves almost no gain, so that 
variable is not (by itself) useful for estimating the distribution of Bradypus.  On the other hand, October 
rainfall (pre6190_l10) allows a reasonably good fit to the training data.  Turning to the lighter blue bars, it 
appears that no variable contains a substantial amount of useful information that is not already contained in 
the other variables, because omitting each variable in turn did not decrease the training gain considerably. 
 
The bradypus.html file has two more jackknife plots, which use either test gain or AUC in place of training 
gain, shown below: 
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Comparing the three jackknife plots can be very informative.  The AUC plot shows that annual 
precipitation (pre6190_ann) is the most effective single variable for predicting the distribution of the 
occurrence data that was set aside for testing, when predictive performance is measured using AUC, even 
though it was hardly used by the model built using all variables.  The relative importance of annual 
precipitation also increases in the test gain plot, when compared against the training gain plot.  In addition, 
in the test gain and AUC plots, some of the light blue bars (especially for the monthly precipitation 
variables) are longer than the red bar, showing that predictive performance improves when the 
corresponding variables are not used.  
 
This tells us that monthly precipitation variables are helping Maxent to obtain a good fit to the training 
data, but the annual precipitation variable generalizes better, giving comparatively better results on the set-
aside test data.  Phrased differently, models made with the monthly precipitation variables appear to be less 
transferable.  This is important if our goal is to transfer the model, for example by applying the model to 
future climate variables in order to estimate its future distribution under climate change.  It makes sense 
that monthly precipitation values are less transferable: likely suitable conditions for Bradypus will depend 
not on precise rainfall values in selected months, but on the aggregate average rainfall, and perhaps on 
rainfall consistency or lack of extended dry periods.  When we are modeling on a continental scale, there 
will probably be shifts in the precise timing of seasonal rainfall patterns, affecting the monthly precipitation 
but not suitable conditions for Bradypus.  
 
In general, it would be better to use variables that are more likely to be directly relevant to the species being 
modeled.  For example, the Worldclim website (www.worldclim.org) provides “BIOCLIM” variables, 
including derived variables such as “rainfall in the wettest quarter”, rather than monthly values. 
 
A last note on the jackknife outputs: the test gain plot shows that a model made only with January 
precipitation (pre6190_l1)  results in a negative test gain.  This means that the model is slightly worse than 
a null model (i.e., a uniform distribution) for predicting the distribution of occurrences set aside for testing.  
This can be regarded as more evidence that the monthly precipitation values are not the best choice for 
predictor variables. 
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How does the prediction depend on the variables? 
 
Now press the “Create response curves”, deselect the jackknife option, and rerun the model.   This results 
in the following section being added to the “bradypus.html” file: 
 

 
 

Each of the thumbnail images can be selected (by clicking on them) to obtain a more detailed plot, and if 
you would like to copy or open these plots with other software, the .png files can be found in the “plots” 
directory.  Looking at vap6190_ann, we see that the response is low for values of vap6190_ann in the range 
1-200, and is higher for values in the range 200-300.  The value shown on the y-axis is predicted 
probability of suitable conditions, as given by the logistic output format, with all other variables set to their 
average value over the set of presence localities. 
 
Note that if the environmental variables are correlated, as they are here, the marginal response curves can 
be misleading.  For example, if two closely correlated variables have response curves that are near 
opposites of each other, then for most pixels, the combined effect of the two variables may be small.  As 
another example, we see that predicted suitability is negatively correlated with annual precipitation 
(pre6190_ann), if all other variables are held fixed.  In other words, once the effect of all the other variables 
has already been accounted for, the marginal effect of increasing annual precipitation is to decrease 
predicted suitability.  However, annual precipitation is highly correlated with the monthly precipitation 
variables, so in reality we cannot easily hold the monthly values fixed while varying the annual value.  The 
program therefore produces a second set of response curves, in which each curve is made by generating a 
model using only the corresponding variable, disregarding all other variables: 
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In contrast to the marginal response to annual precipitation in the first set of response curves, we now see 
that predicted suitability generally increases with increasing annual precipitation.  

 
Feature types and response curves   
 
Response curves allow us to see the difference among different feature types.  Deselect the “auto features”, 
select “Threshold features”, and press the “Run” button again.  Take a look at the resulting feature profiles 
– you’ll notice that they are all step functions, like this one for pre6190_l10: 

 
If the same run is done using only hinge features, the resulting feature profile looks like this: 
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The outlines of the two profiles are similar, but they differ because different feature types allow different 
possible shapes of response curves.  The exponent in a Maxent model is a sum of features, and a sum of 
threshold features is always a step function, so the logistic output is also a step function (as are the raw and 
cumulative outputs).  In comparison, a sum of hinge features is always a piece-wise linear function, so if 
only hinge features are used, the Maxent exponent is piece-wise linear.  This explains the sequence of 
connected line segments in the second response curve above.  (Note that the lines are slightly curved, 
especially towards the extreme values of the variable; this is because the logistic output applies a sigmoid 
function to the Maxent exponent.)  Using all classes together (the default, given enough samples) allows 
many complex responses to be accurately modeled.  A deeper explanation of the various feature types can 
be found by clicking on the help button. 

 
SWD Format 
 
Another input format can be very useful, especially when your environmental grids are very large.  For lack 
of a better name, it’s called “samples with data”, or just SWD.  The SWD version of our Bradypus file, 
called “bradypus_swd.csv”, starts like this: 
 
species,longitude,latitude,cld6190_ann,dtr6190_ann,ecoreg,frs6190_ann,h_dem,pre6190_ann,pre6190_l10,pre6190_l1,
pre6190_l4,pre6190_l7,tmn6190_ann,tmp6190_ann,tmx6190_ann,vap6190_ann 
bradypus_variegatus,-65.4,-10.3833,76.0,104.0,10.0,2.0,121.0,46.0,41.0,84.0,54.0,3.0,192.0,266.0,337.0,279.0 
bradypus_variegatus,-65.3833,-10.3833,76.0,104.0,10.0,2.0,121.0,46.0,40.0,84.0,54.0,3.0,192.0,266.0,337.0,279.0 
bradypus_variegatus,-65.1333,-16.8,57.0,114.0,10.0,1.0,211.0,65.0,56.0,129.0,58.0,34.0,140.0,244.0,321.0,221.0 
bradypus_variegatus,-63.6667,-17.45,57.0,112.0,10.0,3.0,363.0,36.0,33.0,71.0,27.0,13.0,135.0,229.0,307.0,202.0 
bradypus_variegatus,-63.85,-17.4,57.0,113.0,10.0,3.0,303.0,39.0,35.0,77.0,29.0,15.0,134.0,229.0,306.0,202.0 
 
It can be used in place of an ordinary samples file.  The difference is only that the program doesn’t need to 
look in the environmental layers (the ascii files) to obtain values for the variables at the sample points, 
instead it reads the values for the environmental variables directly from the table.  The environmental layers 
are thus only used to read the environmental data for the “background” pixels – pixels where the species 
hasn’t necessarily been detected.  In fact, the background pixels can also be specified in a SWD format file.  
The file “background.csv” contains 10,000 background data points.  The first few look like this: 
 
background,-61.775,6.175,60.0,100.0,10.0,0.0,747.0,55.0,24.0,57.0,45.0,81.0,182.0,239.0,300.0,232.0 
background,-66.075,5.325,67.0,116.0,10.0,3.0,1038.0,75.0,16.0,68.0,64.0,145.0,181.0,246.0,331.0,234.0 
background,-59.875,-26.325,47.0,129.0,9.0,1.0,73.0,31.0,43.0,32.0,43.0,10.0,97.0,218.0,339.0,189.0 
background,-68.375,-15.375,58.0,112.0,10.0,44.0,2039.0,33.0,67.0,31.0,30.0,6.0,101.0,181.0,251.0,133.0 
background,-68.525,4.775,72.0,95.0,10.0,0.0,65.0,72.0,16.0,65.0,69.0,133.0,218.0,271.0,346.0,289.0 
 
We can run Maxent with “bradypus_swd.csv” as the samples file and “background.csv” (both located in the 
“swd” directory) as the environmental layers file.  Try running it – you’ll notice that it runs much faster, 
because it doesn’t have to load the large environmental grids.  Another advantage is that you can associate 
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different records with environmental conditions from different time periods.  For example, two occurrences 
recorded 100 years apart from the same grid cell probably reflect considerable variation in environmental 
conditions, but unless you use SWD format, both records would be given the same environmental variables 
values.  The downside is that it can’t make pictures or output grids, because it doesn’t have all the 
environmental data.  The way to get around this is to use a “projection”, described below. 
 
Batch running 
 
Sometimes you need to generate multiple models, perhaps with slight variations in the modeling parameters 
or the inputs.  Generation of models can be automated with command-line arguments, obviating the need to 
click and type repetitively at the program interface.  The command line arguments can either be given from 
a command window (a.k.a. shell), or they can be defined in a batch file.  Take a look at the file 
“batchExample.bat” (for example, right click on the .bat file in Windows Explorer and open it using 
Notepad).  It contains the following line: 
 
java -mx512m -jar maxent.jar environmentallayers=layers togglelayertype=ecoreg 
samplesfile=samples\bradypus.csv outputdirectory=outputs redoifexists autorun 
 
The effect is to tell the program where to find environmental layers and samples file and where to put 
outputs, to indicate that the ecoreg variable is categorical.  The “autorun” flag tells the program to start 
running immediately, without waiting for the “Run” button to be pushed.  Now try double clicking on the 
file to see what it does. 
 
Many aspects of the Maxent program can be controlled by command-line arguments – press the “Help” 
button to see all the possibilities.   Multiple runs can appear in the same file, and they will simply be run 
one after the other.  You can change the default values of most parameters by adding command-line 
arguments to the “maxent.bat” file.  Many of the command-line arguments also have abbreviations, so the 
run described in batchExample.bat could also be initiated using this command: 
 
java -mx512m -jar maxent.jar –e layers –t eco –s samples\bradypus.csv –o outputs –r -a 
 

Regularization.   
The “regularization multiplier” parameter on the 
settings panel affects how focused or closely-
fitted the output distribution is – a smaller value 
than the default of 1.0 will result in a more 
localized output distribution that is a closer fit to 
the given presence records, but can result in to 
overfitting (fitting so close to the training data 
that the model doesn’t generalize well to 
independent test data).  A larger regularization 
multiplier will give a more spread out, less 
localized prediction.  Try changing the 
multiplier, and examine the pictures produced 
and changes in the AUC.  As an example, setting 
the multiplier to 3 makes this picture, showing a 
much more diffuse distribution than before: 

 
The potential for overfitting increases as the 
model complexity increases.  First try setting the 
multiplier very small (e.g. 0.01) with the default 
set of features to see a highly overfit model.  
Then try the same regularization multiplier with 
only linear and quadratic features. 
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Projecting 
 
A model trained on one set of environmental layers (or SWD file) can be “projected” by applying it to 
another set of environmental layers (or SWD file).  Situations where projections are needed include 
modeling species distributions under changing climate conditions, applying a model of the native 
distribution of an invasive species to assess invasive risk in a different geographic area, or simply 
evaluating the model at a set of test locations in order to do further statistical analysis.  Here we’re going to 
use projection for a very simple task: to make an output ascii grid and associated picture when the samples 
and background are in SWD format.   
 
Type in, or browse for, the samples file “swd\bradypus_swd.csv” and the environmental layers in 

“swd\background.csv”, 
then enter the “layers” 
directory in the 
“Projection Layers 
Directory”, as pictured to 
left.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The projection layers directory (or SWD file) must contain variables with the same names as the variables 
used for training the model, but describing a different conditions (e.g., a different geographic region or 
different climatic model).  For both the training and projection data, each variable name is either the 
column title (if using an SWD format file) or the filename without the .asc file ending (if using a directory 
of grids). 
 
When you press “Run”, a model is trained on the SWD data, and then projected onto the full ascii grids in 
the “layers” directory.  The output ascii grid is called “bradypus_variegatus_layers.asc”, and in general, the 
projection directory name is appended to the species name, in order to distinguish it from the standard (un-
projected) output.  If “make pictures of predictions” is selected, a picture of the projected model will appear 
in the “bradypus.html” file.   
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Analyzing Maxent output in R 
 
Maxent produces a number of output files for each run.  Some of these files can be imported into other 
programs if you want to do your own analysis of the predictions.  Here we demonstrate the use of the free 
statistical package R on Maxent outputs: this section is intended for users who have experience with R.  We 
will use the following two files produced by Maxent:  
 
   bradypus_variegatus.csv 
   bradypus_variegatus_samplePredictions.csv 
 
The first of these is produced when the background data are given in SWD format, and the second is 
always produced.  Make sure you have test data (for example, by setting the random test percentage to 25); 
we will be evaluating the Maxent outputs using the same test data Maxent used.  First we start R, and 
install some packages (assuming this is the first time we’re using them) and then load them by typing (or 
pasting): 
 
   install.packages("ROCR", dependencies=TRUE) 
   install.packages("vcd",  dependencies=TRUE) 
   library(ROCR) 
   library(vcd) 
   library(boot) 
 
Throughout this section we will use blue text to show R code and commands and green to show R outputs.  
Next we change directory to where the Maxent outputs are, for example: 
 
  setwd(“c:/maxent/tutorial/outputs”) 
 
and then read in the Maxent predictions at the presence and background points, and extract the columns we 
need: 
 
   presence <- read.csv(“bradypus_variegatus_samplePredictions.csv") 
   background <- read.csv(“bradypus_variegatus.csv") 
   pp <- presence$Cumulative.prediction                # get the column of predictions 
   testpp <- pp[presence$Test.or.train=="test"]       # select only test points 
   trainpp <- pp[presence$Test.or.train=="train"]   # select only test points 
   bb <- background$Maxent.cumulative.values.at.background.points 
 
 
 
Now we can put the prediction values into the format required by ROCR, the package we will use to do 
some ROC analysis, and generate the ROC curve: 
 
   combined <- c(testpp, bb)                                    # combine into a single vector 
   label <- c(rep(1,length(testpp)),rep(0,length(bb)))  # labels: 1=present, 0=random 
   pred <- prediction(combined, label)                    # labeled predictions 
   perf <- performance(pred, "tpr", "fpr")               # True / false positives, for ROC curve 
   plot(perf, colorize=TRUE)                                  # Show the ROC curve 
   performance(pred, "auc")@y.values[[1]]            # Calculate the AUC 
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The plot command gives the following result: 
 
 

while the “performance” command gives an AUC value of 
0.8677759, consistent with the AUC reported by Maxent.   
 
 
 
 
 
 
 
 
Next, as an example of a test available in R but not in Maxent, 
we will make a bootstrap estimate of the standard deviation of the AUC. 
 
   AUC <- function(p,ind) { 
     pres <- p[ind] 
     combined <- c(pres, bb) 
     label <- c(rep(1,length(pres)),rep(0,length(bb))) 
     predic <- prediction(combined, label) 
     return(performance(predic, "auc")@y.values[[1]]) 
   } 
 
  b1 <- boot(testpp, AUC, 100)  # do 100 bootstrap AUC calculations 
  b1                                             # gives estimates of standard error and bias 
 
This gives the following output: 
 
   ORDINARY NONPARAMETRIC BOOTSTRAP 
 
   Call: 
   boot(data = testpp, statistic = AUC, R = 100) 
 
   Bootstrap Statistics : 
        original      bias    std. error 
t1* 0.8677759 -0.0003724138  0.02972513 
 
and we see that the bootstrap estimate of standard error (0.02972513) is close to the standard error 
computed by Maxent (0.028).  The bootstrap results can also be used to determine confidence intervals for 
the AUC: 
 
   boot.ci(b1) 
 
gives the following four estimates – see the resources section at the end of this tutorial for references that 
define and compare these estimates. 
   Intervals :  
   Level      Normal              Basic          
   95%   ( 0.8099,  0.9264 )   ( 0.8104,  0.9291 )   
 
   Level     Percentile            BCa           
   95%   ( 0.8064,  0.9252 )   ( 0.7786,  0.9191 )   
    
Those familiar with use of the bootstrap will notice that we are bootstrapping only the presence values here.  
We could also bootstrap the background values, but the results would not change much, given the very 
large number of background values (10000). 
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As a final example, we will investigate the calculation of binomial and Cohen’s Kappa statistics for some 
example threshold rules.  First, the following R code calculates Kappa for the threshold given by the 
minimum presence prediction: 
 
   confusion <- function(thresh) { 
     return(cbind(c(length(testpp[testpp>=thresh]), length(testpp[testpp<thresh])), 
                  c(length(bb[bb>=thresh]), length(bb[bb<thresh])))) 
   } 
   mykappa <- function(thresh) { 
     return(Kappa(confusion(thresh))) 
   } 
   mykappa(min(trainpp)) 
 
which gives a value of 0.0072.  If we want to use the threshold that minimizes the sum of sensitivity and 
specificity on the test data, we can do the following, using the true positive rate and false positive rate 
values from the “performance” object used above to plot the ROC curve: 
 
   fpr = perf@x.values[[1]] 
   tpr = perf@y.values[[1]] 
   maxsum = 0 
   for (i in 1:length(perf@alpha.values[[1]])) { 
      sum = tpr[[i]] + (1-fpr[[i]]) 
      if (sum > maxsum) { 
         maxsum = sum 
         cutoff = perf@alpha.values[[1]][[i]] 
         index = i 
      } 
   } 
   mykappa(cutoff) 
 
This gives a kappa value of 0.0144.  To determine binomial probabilities for these two threshold values, we 
can do: 
 
   mybinomial <- function(thresh) { 
     conf <- confusion(thresh) 
     trials <- length(testpp) 
     return(binom.test(conf[[1]][[1]], trials, conf[[1,2]] / length(bb), "greater")) 
   } 
   mybinomial(min(trainpp)) 
   mybinomial(cutoff) 
 
This gives p-values of 5.979e-09 and 2.397e-11 respectively, which are both slightly larger than the p-
values given by Maxent.  The reason for the difference is that the number of test samples is greater than 25, 
the threshold above which Maxent uses a normal approximation to calculate binomial p-values. 
 
 
R Resources 
Some good introductory material on using R can be found at: 
 
http://spider.stat.umn.edu/R/doc/manual/R-intro.html (plus other pages) 
 
http://www.math.ilstu.edu/dhkim/Rstuff/Rtutor.html 
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 Displaying Modeling Results: 
How to display and reclassify Maxent results in ArcMap  

 
 
Though Maxent results can be seen in its output picture format, you have much more control 
over the visualization and analysis using ArcMap.   
 
1. To access the model output file, open ArcMap, and Arc Toolbox.  In the toolbox, go to 
Conversion Tools > To Raster > ASCII to Raster.  

 

 
 

2. Select the Maxent output ASCII file (be sure the files of type is set to .asc) for the input file, 
and choose a directory and name for your output (ESRI grid file).  Choose “FLOAT” so that the 
decimals are maintained and click OK. 
 

 

RS/GIS Quick Start Guides   Geospatial Innovation Facility 
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3. Once completed, you will see a greyscale image of the results. 
 

 
 
4. Fine control of display is under Layer properties which can be accessed by double-clicking the 
layer name in the table of contents, and choose the Symbology tab. 
 

 

RS/GIS Quick Start Guides   Geospatial Innovation Facility 
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5. For example, choose “Minimum-Maximum” as the Stretch Type, and a color ramp of your 
choice.  You can click apply to see the results, or check the Edit High/Low Values box to change 
these values.  
 

 
 

 

RS/GIS Quick Start Guides   Geospatial Innovation Facility 
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6. Next, we can reclassify the image in order to delimit a binary result.  Make sure that the 
Spatial Analyst Extension is checked on: Tools > Extensions, and access the Spatial Analyst 
toolbar through View > Toolbars > Spatial Analyst. 
 

 
 
7. Go to Reclassify in the Spatial Analyst drop down menu. And click on the “Classify” button to 
access the Classification menu.   
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. In the classification menu, choose “2” for the number of classes, and enter the desired 
threshold in the Break Values.  You can consult the Maxent html output for a table of suggested 
thresholds. Click OK. 
 

RS/GIS Quick Start Guides   Geospatial Innovation Facility 
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RS/GIS Quick Start Guides  
These materials are freely available for use and modification through a  
Creative Commons Attribution-Share Alike 3.0 License. 
License details: http://creativecommons.org/licenses/by-sa/3.0/us/ 
Version: Original document was created by GIF (2008); Modified by MSK for AmphibiaTree Dec 2008. 

9. Back in the Classify menu, change the new value for the lower range “NoData” and change 
the range for the positive values as “1”.  Choose an output directory and file name, and click 
OK. 

 

 
 

9. You should see the resulting file in the map, where all of the positive areas equal “1” and the 
negative areas equal “0”.   
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Resource List 
Updated December 2008 

Software: 
 
DIVA-GIS -- (http://www.diva-gis.org/)  
Currently maintained and developed by Robert Hijmans; info@diva-gis.org 
 
MAXENT – (http://www.cs.princeton.edu/~schapire/maxent/) 
Actively developed, contact phillips@research.att.com for bugs, comments, suggestions 
 
ArcGIS 9 (ESRI) – Decidedly NOT Free but like Microsoft, ESRI software is everywhere and 
many scripts, tutorials, and help are free and available in most GIS labs. 
 
For a longer list of Free GIS software, I have made a list of software for PC, Mac and Linux 
that I have tried on the MVZ GIS Resource website: http://mvzgis.googlepages.com/gissoftware 
 
 

Species Data: 
 

- Data for a wide range of taxa including 
plants, global 

Global Biodiversity Information Facility (GBIF):  
www.gbif.org 

HerpNET, reptile and amphibian data from  HerpNET: 
www.herpnet.org/ 

Climate 
 

- Interpolated climate surfaces for the globe at 
1km resolution 

WorldClim: 
www.worldclim.org/ 

-Archive of fine-resolution translations of 112 
contemporary climate projections for 
contiguous US (IPCC 4th assessment) 

World Climate Research Programme (WCRP)’s Coupled 
Model Intercomparison Project Phase 3 (CMIP3) 

http://gdo-dcp.ucllnl.org/downscaled_cmip3_projections/ 
- Scenarios of future climate change for the 

globe 
Intergovernmental Panel on Climate Change (IPCC):  

http://www.ipcc-data.org/index.html  
- GIS Climate Change Scenarios for US and 

globe (IPCC 4th assessment); downscaled 
variables for US (4.5 km) include Average 
Air Temp (tas), Total Precipitation (ppt) mm 

NCAR’s GIS Climate Change Scenarios 
      http://www.gisclimatechange.org/ 

- Reconstructed palaeoclimates NOAA:  
http://www.ncdc.noaa.gov/paleo/paleo.html 

Topography 
 

- Elevation and related variables for the globe 
(1 km) and US (10m, 30m, 90m) 

 

USGS: 
http://edc.usgs.gov/products/elevation/ 

http://www.diva-gis.org/
http://www.cs.princeton.edu/%7Eschapire/maxent/
http://mvzgis.googlepages.com/gissoftware
http://www.gbif.org/
http://www.herpnet.org/
http://www.worldclim.org/
http://www.ipcc-data.org/index.html
http://www.ncdc.noaa.gov/paleo/paleo.html
http://edc.usgs.gov/products/elevation/


Remote sensing (satellite)  
- Landsat, AVHHR, NDVI and other various 

land cover datasets 
Global Landcover Facility:  

http://glcf.umiacs.umd.edu/data/ 
-USGS-sponsored site for accessing aerial and 

satellite archives of ASTER, EO-1, Landsat 
Archives, Landsat Decadal, Landsat Science, 
MODIS Aqua, MODIS Terra, and TerraLook 
(georectified JPGs of Landsat and ASTER 
datasets) 

GLOVIS 
http://glovis.usgs.gov/ 

- Various atmospheric and land products from 
the MODIS instrument 

NASA: 
http://modis.gsfc.nasa.gov/data/ 

Soils 
 

- Global soil types UNEP:  
http://www.grid.unep.ch/data/data.phpcategory= 
lithosphere 

Marine  
 

Many of the above climate resources also include ocean variables and marine climate change scenarios. 
- Various datasets describing the world’s 

oceans 
NOAA: 

www.nodc.noaa.gov 
 

 
 

Other Modeling Software (not covered in workshop): 
 
Desktop GARP—Genetic Algorithm for Rule-set Production (Stockwell & Peterson 1999) 
http://www.nhm.ku.edu/desktopgarp/ 
 
GRASP—Generalized Regression Analysis and Spatial Prediction (Lehmann A., Overton J.McC. & 
Leathwick, J.R. GRASP: Generalized regression analysis and spatial predictions, Ecological Modelling, 157: 189-
207.)  http://www.unine.ch/cscf/grasp/ 
Originally for S-PLUS, there is now GRASP for R. 
 
BIOMAPPER—GIS and statistical program to implement Ecological Niche Factor Analysis 
(ENFA) (http://www2.unil.ch/biomapper/index.html) Hirzel A.H., Hausser J., Chessel D. & Perrin N. 
(2002) Ecological-niche factor analysis: How to compute habitat- suitability maps without absence data? Ecology, 
83, 2027-2036. (see website for more articles) 
 
openModeller—(http://openmodeller.sourceforge.net/) open source application that implements 
a variety of plugin modules to run a suite of modeling methods, including Bioclim, Broken-Stick 
(climate space model), Environmental Distance, GARP, Support Vector Machines. Recently 
GBIF portal offers a version that allows modeling of a occurrence record search with 
openModeller in Java. 
 

http://glcf.umiacs.umd.edu/data/
http://modis.gsfc.nasa.gov/data/
http://www.grid.unep.ch/data/data.php
http://www.nodc.noaa.gov/
http://www.nhm.ku.edu/desktopgarp/
http://www.unine.ch/cscf/grasp/
http://www2.unil.ch/biomapper/index.html
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